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Getting Started 

Screen Layout 

 

Menus 
When you begin to explore Word 2000, you will notice a significant change in the menu 
structure if you are familiar with previous versions of Word. The menus in Word 2000 display 
only the commands you have recently used.  To view all options in each menu, you must 
click the double arrows at the bottom of the menu. The images below show the Format menu 
collapsed (left) and expanded (right) after the double arrows at the bottom of the menu were 
clicked: 
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Follow the steps below to display menus similar to previous versions of Word with all the 
choices listed initially: 

1. Select View|Toolbars|Customize from the menu bar.  
2. Click on the Options tab.  
3. Uncheck the Menus show recently used commands first check box. 

 

Shortcut Menus 
These features allow you to access various Word commands faster than using the options on 
the menu bar. View shortcut menus by right-clicking with the mouse. The options on this 
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menu will vary depending on the element that was right-clicked. For example, the shortcut 
menu below is produced by right-clicking on a bulleted list.  

 
Actions such as "Decrease Indent" and "Increase Indent" are only applicable to lists and 
therefore only appear on the list shortcut menu. The shortcut menus are helpful because they 
only display the options that can be applied to the item that was right-clicked and, therefore, 
prevent searching through the many menu options. 
Toolbars 
Many toolbars displaying shortcut buttons are also available to make editing and formatting 
quicker and easier. Select View Toolbars from the menu bar to select the toolbars. The 
toolbars that are already displayed on the screen are checked. Add a toolbar simply by 
clicking on the name. 
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Customizing Toolbars 
There may be certain actions on a toolbar that you do not use and there may also be 
commands that you execute often but that are not located on any toolbar. Word toolbars can 
be customized so these commands can be added and deleted. 

1. Select View|Toolbars|Customize and click the Commands tab. 

 
2. By highlighting the command categories in the Categories box, the choices will change in the 

Commands box to the right.  
3. Select the command you would like to add to the toolbar by selecting it in the Commands box.  
4. Drag the command with the mouse to the desired location on the toolbar and release the mouse button.  
5. Remove a button from the toolbar by clicking and dragging the button off the toolbar. 

 

Working with Files 

There are several ways to create new documents, open existing documents, and save 
documents in Word: 

Create a New Document  

1. Click the New Document button on the menu bar.  
2. Choose File|New from the menu bar.  
3. Press CTRL+N (depress the CTRL key while pressing "N") on the keyboard.  

Open an Existing Document  

1. Click the Open File button on the menu bar.  
2. Choose File|Open from the menu bar.  
3. Press CTRL+O on the keyboard.  

 
Each method will show the Open dialog box. Choose the file and click the Open button.  
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Save a Document  

1. Click the Save button on the menu bar.  
2. Select File|Save from the menu bar.  
3. Press CTRL+S on the keyboard.  

Renaming Documents 
To rename a Word document while using the program, select File|Open and find the file you 
want to rename. Right-click on the document name with the mouse and select Rename from 
the shortcut menu. Type the new name for the file and press the ENTER key. 
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Working on Multiple Documents 
Several documents can be opened simultaneously if you are typing or editing multiple 
documents at once.  All open documents are listed under the Window menu as shown 
below. The current document has a checkmark beside the file name. Select another name to 
view another open document or click the button on the Windows taskbar at the bottom of the 
screen. 

 
Close a Document  
Close the current document by selecting File|Close or click the Close icon if it's visible on the 
Standard Toolbar.  
 
 

Working with Text  

Typing and Inserting Text 
To enter text, just start typing! The text will appear where the blinking cursor is located. Move 
the cursor by using the arrow buttons on the keyboard or positioning the mouse and clicking 
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the left button. The keyboard shortcuts listed below are also helpful when moving through the 
text of a document: 

Move Action Keystroke 
Beginning of the line HOME 
End of the line END 
Top of the document CTRL+HOME 
End of the document CTRL+END  

Selecting Text 
To change any attributes of text it must be highlighted first. Select the text by dragging the 
mouse over the desired text while keeping the left mouse button depressed, or hold down the 
SHIFT key on the keyboard while using the arrow buttons to highlight the text. The following 
table contains shortcuts for selecting a portion of the text: 

Selection Technique 
Whole word double-click within the word 
Whole paragraph triple-click within the paragraph 
Several words or lines drag the mouse over the words, or hold down SHIFT while using the arrow keys 
Entire document choose Edit|Select All from the menu bar, or press CTRL+A  

Deselect the text by clicking anywhere outside of the selection on the page or press an arrow 
key on the keyboard. 
 
Deleting text 
Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace will 
delete text to the left of the cursor and Delete will erase text to the right. To delete a large 
selection of text, highlight it using any of the methods outlined above and press the DELETE 
key.  

Formatting Text 
The formatting toolbar is the easiest way to change many attributes of text. If the toolbar as 
shown below isn't displayed on the screen, select View|Toolbars and choose Formatting. 

 

 
Style Menu - Styles are explained in detail later in this tutorial.  
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Font Face - Click the arrowhead to the right of the font name box to view the list of fonts available. Scroll 
down to the font you want and select it by clicking on the name once with the mouse. A serif font (one with 
"feet" circled in the illustration below) is recommended for paragraphs of text that will be printed on paper as 
they are most readable. The following graphic demonstrates the difference between serif (Times New 
Roman on the left) and sans-serif ("no feet", Arial on the right) fonts. 

 
 

 
Font Size - Click on the white part of the font size box to enter a value for the font size or click the arrowhead 
to the right of the box to view a list of font sizes available. Select a size by clicking on it once. A font size of 
10 or 12 is best for paragraphs of text. 

 

 
Font Style - Use these buttons to bold, italicize, and underline text. 

 

 
Alignment - Text can be aligned to the left, center, or right side of the page or it can be justified across the 
page. 

 
Numbered and Bulleted Lists - Lists are explained in detail later in this tutorial. 

 
Increase/Decrease Indent - Change the indentation of a paragraph in relation to the side of the page. 

 

 
Outside Border - Add a border around a text selection. 

 

 
Highlight Color - Use this option to change the color behind a text selection. The color shown on the button 
is the last color used. To select a different color, click the arrowhead next to the image on the button. 

 

 
Text Color - This option changes the color of the text. The color shown on the button is the last color chosen. 
Click the arrowhead next to the button image to select another color. 
 
The Font dialog box allows you to choose from a larger selection of formatting options. Select Format|Font 
from the menu bar to access the box. 
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Format Painter  
A handy feature for formatting text is the Format Painter located on the standard toolbar. For 
example, if you have formatting a paragraph heading with a certain font face, size, and style 
and you want to format another heading the same way, you do not need to manually add 
each attribute to the new headline. Instead, use the Format Painter by following these steps:  

1. Place the cursor within the text that contains the formatting you want to copy.  
2. Click the Format Painter button in the standard toolbar. Notice that your pointer now has a paintbrush 

beside it.  
3. Highlight the text you want to add the same format to with the mouse and release the mouse button.  

To add the formatting to multiple selections of text, double-click the Format Painter button 
instead of clicking once.  The format painter then stays active until you press the ESC key to 
turn it off.  
Undo  
Feel free to experiment with various text styles. You can always undo your last action by 
clicking the Undo button on the standard toolbar or selecting Edit|Undo... from the menu bar. 
Click the Redo button on the standard toolbar or select Edit|Redo... to erase the undo action. 
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Formatting Paragraphs 

Paragraph Attributes 
Format a paragraph by placing the cursor within the paragraph and selecting 
Format|Paragraph from the menu bar. 

 

Moving (Cutting) Text  
Highlight the text that will be moved and select Edit|Cut from the menu bar, click the Cut 
button on the standard tool bar, or press CTRL+X at once. This will move the text to a 
clipboard. 
 
To move a small amount of text a short distance, the drag-and-drop method may be quicker. 
Highlight the text you want to move, click the selection with the mouse, drag the selection to 
the new location, and release the mouse button. 
 
Copying Text  
To copy text, choose Edit|Copy, click the Copy button on the standard toolbar, or press 
CTRL+C to copy the text to the clipboard. 
 
Paste Text  
To paste cut or copied text, move the cursor to the location you want to move the text to and 
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select Edit|Paste from the menu bar, click the Paste button on the standard toolbar, or press 
CTRL+V.  

The Clipboard 
The last 12 elements that were cut or copied are placed onto Word's clipboard. You can view 
the elements on the clipboard by selecting View|Toolbars|Clipboard from the menu bar. 

 

Place the mouse arrow over each element in the clipboard to view the contents of each item 
and click on an element to add its contents to the document. Click Paste All to add all of the 
items to the document at once. Click the Clear Clipboard button (the icon with an "X" over 
the clipboard image) to clear the contents of the clipboard. 

Columns  
To quickly place text in a column format, click the Columns button on the standard toolbar 
and select the number of columns by dragging the mouse over the diagram. 

 

For more column options, select Format|Columns from the menu bar. The Columns dialog 
box allows you to choose the properties of the columns. Select the number and width of the 
columns from the dialog box. 
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Drop Caps 
A drop cap is a large letter that begins a paragraph and drops through several lines of text as 
shown below. 

 

Add a drop cap to a paragraph by following these steps: 

1. Place the cursor within the paragraph whose first letter will be dropped.  
2. Select Format|Drop Cap from the menu bar.  
3. The Drop Cap dialog box allows you to select the position of the drop cap, the font, the number of lines 

to drop, and the distance from the body text.  
4. Click OK when all selections have been made.  
5. To modify a drop cap, select Format|Drop Cap again to change the attributes, or click on the letter and 

use the handles to move and resize the letter.  
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Styles 
 

The use of styles in Word will allow you to quickly format a document with a consistent and 
professional look. Paragraph and character styles can be saved for use in many documents. 

 

Applying a Style 

1. Place the cursor in the paragraph where the style will be applied.  
2. Click the Style drop-down menu on the Formatting toolbar and select a style by clicking on it.  

3. To apply the same style to multiple paragraphs, double click the Format Painter button on the 
standard toolbar and click in all the paragraphs that the style should be applied to. Press the ESC key to 
disable the Format Painter.  

Apply a Style from the Style Dialog Box 
Choose from a larger selection of styles from the Style dialog box. 
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1. Click in the paragraph you want to add a style to.  
2. Select Format|Style... from the menu bar.  
3. From the List drop-down menu, choose All styles to view all the styles available.  
4. The styles are displayed in the Styles list. Preview each style by clicking once on the name. Paragraph 

styles are preceded by the paragraph symbol ( ) and character styles are preceded by an "a" icon ( ). A 
pointer arrow is located next to the current style. Highlight the style you want to apply to the paragraph 
and click Apply.  

Create a New Style from a Model 
To create a style from text that is already formatted in a document, follow these steps: 

1. Place the cursor in the paragraph you would like to set as a new style.  
2. Click the Style box on the formatting toolbar so the style name is highlighted. 

 
3. Delete the text in the field and type the name of the new style.  
4. Press the ENTER key to save the new style.  
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Create a Simple Style from the Style Dialog Box 

1. Select Format|Style... from the menu bar and click the New button on the Style dialog box to access 
the New Style dialog box.  

 
2. Type the name for the new style in the Name field.  
3. Select "Paragraph" or "Character" from the Style type drop-down menu.  
4. Click the Format button at the bottom of the window and choose the paragraph element that will be 

formatted for the style. Continue to make changes from the options from the Format button menu, 
making changes to the dialog boxes for each element you choose.  

5. Click OK to set the style and close the New Style dialog box.  
6. Click Apply on the Style dialog box to apply the new style to the current paragraph.  

Modify or Rename a Style 
An existing style can be changed from the Style dialog box. 

1. Select Format|Style... from the menu bar.  
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2. Highlight the style from the Styles list that you want to modify and click the Modify button. 

 
3. Use the same methods to modify the style from the Modify Style dialog box that were used for the New 

Style box.  
4. To only rename the style, type a new name in the Name field.  
5. Click OK when you are finished making modifications.  
6. Click Apply to update the style in the document.  

Delete a Style 
Preset styles created by Word cannot be deleted, but to delete a style you have made, follow 
these steps: 

1. Select Format|Style... from the menu bar  
2. Highlight the style from the Styles list that you want to delete.  
3. Click the Delete button.  
4. You will be asked if you really want to delete the style. Click Yes.  
5. Click Close on the dialog box.  

Lists 

To create a bulleted or numbered list, use the list features provided by Word.  

Bulleted and Numbered Lists  

1. Click the Bulleted List button or Numbered List button on the formatting toolbar.  
2. Type the first entry and press ENTER.  This will create a new bullet or number on the next line. If you 

want to start a new line without adding another bullet or number, hold down the SHIFT key while 
pressing ENTER.  

3. Continue to typing entries and press ENTER twice when you are finished typing to end the list.  

Use the Increase Indent and Decrease Indent buttons on the formatting toolbar to 
create lists of multiple levels. 
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NOTE: You can also type the text first, highlight the section, and press the Bulleted List or 
Numbered List buttons to add the bullets or numbers.  
Nested Lists 
To create a nested list, such as a numbered list inside of a bulleted list, follow these steps: 

1. Type the list and increase the indentation of the items that will make up the nested list by clicking the 
Increase Indent button for each item. 

 
2. Highlight the items and click the Numbered List button on the formatting toolbar.  

Formatting Lists 
The bullet image and numbering format can be changed by using the Bullets and 
Numbering dialog box. 

1. Highlight the entire list to change all the bullets or numbers, or 
Place the cursor on one line within the list to change a single bullet.  

2. Access the dialog box by selecting Format|Bullets and Numbering from the menu bar or by right-
clicking within the list and selecting Bullets and Numbering from the shortcut menu. 

 
3. Select the list style from one of the seven choices given, or click the Picture... button to choose a 

different icon. Click the Numbered tab to choose a numbered list style.  
4. Click OK when finished. 

Tables 
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Tables are used to display data and there are several ways to build them in Word. Begin by 
placing the cursor where you want the table to appear in the document and choose one of the 
following methods. 

Insert a Table 
There are two ways to add a table to the document using the Insert feature: 

1. Click the Insert Table button on the standard toolbar. Drag the mouse along the grid, highlighting the 
number of rows and columns for the table. 

 
2. Or, select Table|Insert|Table from the menu bar. Select the number of rows and columns for the table 

and click OK. 

 

Draw the Table 
A table can also be drawn onto the document: 

1. Draw the table by selecting Table|Draw Table from the menu bar. The cursor is now the image of a 
pencil and the Tables and Borders toolbar has appeared. 

 



Shree M. & N. Virani Science College 

2. Draw the cells of the table with the mouse. If you make a mistake, click the Eraser button and drag 
the mouse over the area to be deleted.  

3. To draw more cells, click on the Draw Table button .  

Inserting Rows and Columns 
Once the table is drawn, insert additional rows by placing the cursor in the row you want to be 
adjacent to. Select Table|Insert|Rows Above or Rows Below. Or, select an entire row and 
right-click with the mouse. Choose Insert Rows from the shortcut menu. 
 
Much like inserting a row, add a new column by placing the cursor in a cell adjacent to where 
the new column will be added. Select Table|Insert|Columns to the Left or Columns to the 
Right. Or, select the column, right-click with the mouse, and select Insert Columns. 
Moving and Resizing a Table 
A four-sided moving arrow and open box resizing handle will appear on the corners of the 
table if the mouse is placed over the table. Click and drag the four-ended arrow to move the 
table and release the mouse button when the table is positioned where you want it. Click and 
drag the open box handle to resize the table. Change the column widths and row heights by 
clicking the cell dividers and dragging them with the mouse. 

 
Tables and Borders Toolbar 
The Tables and Borders toolbar allows you to add border styles, shading, text effects, 
alignment, and more options to your table. Access the toolbar by clicking Table|Draw Table 
or View|Toolbars|Tables and Borders. 

 
You will need to highlight the cells of the table you want to format. Click and drag the mouse 
over the cells, or use the following shortcuts: 
Selection Menu Method Mouse Method 
One cell Table|Select|Cell Click the bottom, left corner of the cell when a black arrow appears  
One row Table|Select|Row Click outside the table to the left of the row 

One column Table|Select|Column Click outside the table above the column when a black arrow 
appears 

Several rows (none) Click outside the table to the left of the row and drag the mouse 
down 

Several 
columns (none) Click outside the table above the column 

Entire table Table|Select|Table Triple-click to the left of the table  
Table Properties 
Use the Table Properties dialog box to modify the alignment of the table with the body text 
and the text within the table. Access the box by selecting Tables|Table Properties. 
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Size - Check the Preferred width box and enter a value if the table should be an exact width. 

 
Alignment - Highlight the illustration that represents the alignment of the table in relation to the text of the 
document. 

 
Text wrapping - Highlight "None" if the table should appear on a separate line from the text or choose 
"Around" if the text should wrap around the table. 

 
Borders and Shading - Select from a number of border styles, colors, and widths. Click the Shading tab to 
change the background color and pattern.
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Options - Click the Options button on the Table Properties window. To change the spacing between the 
document text and the table borders under Default cell margins. Check the Allow spacing between cells 
box and enter a value to add space between the table cells. 

 
 
 

Adding Graphics 

Adding Clip Art 
To add a clip art image from the Microsoft library to a document, follow these steps: 
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1. Select Insert|Picture|Clip Art from the menu bar. 

 
2. To find an image, click in the white box following Search for clips. Delete the words "Type one or more 

words. . ." and enter keywords describing the image you want to use. 
- OR - 
Click one of the category icons.  

3. Click once on the image you want to add to the document and the following popup menu will appear: 

 
 

 
Insert Clip to add the image to the document. 

 

 
Preview Clip to view the image full-size before adding it to the document. Drag the bottom, right corner of the 
preview window to resize the image and click the "x" close button to end the preview. 
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Add Clip to Favorites will add the selected image to your favorites directory that can be chosen from the 
Insert ClipArt dialog box.  

 
Find Similar Clips will retrieve images similar to the one you have chosen.  

4. Continue selecting images to add to the document and click the Close button in the top, right corner of 
the Insert ClipArt window to stop adding clip art to the document. 

Add An Image from a File 
Follow these steps to add a photo or graphic from an existing file: 

1. Select Insert|Picture|From File on the menu bar. 
2. Click the down arrow button on the right of the Look in: window to find the image on your computer.  
3. Highlight the file name from the list and click the Insert button. 

 

Editing A Graphic  
Activate the image you wish to edit by clicking on it once with the mouse. Nine handles will 
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appear around the graphic. Click and drag these handles to resize the image. The handles on 
the corners will resize proportionally while the handles on the straight lines will stretch the 
image. More picture effects can be changed using the Picture toolbar. The Picture toolbar 
should appear when you click on the image. Otherwise, select View|Toolbars|Picture from 
the menu bar to activate it. 

 

 
Insert Picture will display the image selection window and allows you to change the image. 
 

 

 
Image Control allows to to make the image grayscale, black and white, or a watermark. 
 

 

 
More/Less Contrast modifies the contrast between the colors of the image. 
 

 

 
More/Less Brightness will darken or brighten the image. 
 

 

 
Click Crop and drag the handles on the activated image to delete outer portions of the image. 
 

 

 
Line Style will add a variety of borders to the graphic. 
 

 

 
Text Wrapping will modify the way the document text wraps around the graphic. 
 

 

 
Format Picture displays all the image properties in a separate window. 
 

 

 
Reset Picture will delete all the modifications made to the image. 

Auto Shapes 
The AutoShapes toolbar will allow you to draw many different geometrical shapes, arrows, 
flow chart symbols, stars, and banners on the document. Activate the AutoShapes toolbar by 
selecting Insert|Picture|AutoShapes or View|Toolbars|AutoShapes from the menu bar, or 
clicking the AutoShapes button on the Drawing toolbar. Click each button on the toolbar to 
view the options for drawing the shape. 

“Yogidham”, Kalawad Road, Rajkot – 5 Ph : 2576681 26



Shree M. & N. Virani Science College 

 

 
Lines - After clicking the Lines button on the AutoShapes toolbar, draw a straight line, arrow, or double-
ended arrow from the first row of options by clicking the respective button. Click in the document where you 
would like the line to begin and click again where it should end. To draw a curved line or freeform shape, 
select curved lines from the menu (first and second buttons of second row), click in the document where the 
line should appear, and click the mouse every time a curve should begin. End creating the graphic by clicking 
on the starting end or pressing the ESC key. To scribble, click the last button in the second row, click the 
mouse in the document and hold down the left button while you draw the design. Let go of the mouse button 
to stop drawing. 

 

 
Basic Shapes - Click the Basic Shapes button on the AutoShapes toolbar to select from many two- and 
three-dimensional shapes, icons, braces, and brackets. Use the drag-and-drop method to draw the shape 
in the document. When the shape has been made, it can be resized using the open box handles and other 
adjustments specific to each shape can be modified using the yellow diamond handles. 

 
 

 

 
Block Arrows - Select Block Arrows to choose from many types of two- and three-dimensional arrows. 
Drag-and-drop the arrow in the document and use the open box and yellow diamond handles to adjust the 
arrowheads. Each AutoShape can also be rotated by first clicking the Free Rotate button on the drawing 
toolbar . Click and drag the green handles around the image to rotate it. The tree image below was 
created from an arrow rotated 90 degrees. 

 
 

 

 
Flow Chart - Choose from the flow chart menu to add flow chart elements to the document and use the line 
menu to draw connections between the elements. 
 

 

 
Stars and Banners - Click the button to select stars, bursts, banners, and scrolls.  
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Call Outs - Select from the speech and thought bubbles, and line call outs. Enter the call out text in the 
text box that is made. 
 

 

 
More AutoShapes - Click this button to choose from a list of clip art categories.  

Each of the submenus on the AutoShapes toolbar can become a separate toolbar. Just click 
and drag the gray bar across the top of the submenus off of the toolbar and it will become a 
separate floating toolbar. 

 

 
 
 

Autocorrect and Spelling and Grammar 
 

AutoCorrect 
Word automatically corrects many commonly misspelled words and punctuation marks with 
the AutoCorrect feature. To view the list of words that are automatically corrected, select 
Tools|AutoCorrect. This may be a hidden feature so click the double arrows at the bottom of 
the Tools menu listing if the AutoCorrect choice is not listed. 
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Many options including the accidental capitalization of the first two letters of a word and 
capitalization of the first word of the sentence can be automatically corrected from this page. 
If there are words you often misspell, enter the wrong and correct spellings in the Replace 
and With fields. 

Spelling and Grammar Check 
Word will automatically check for spelling and grammar errors as you type unless you turn 
this feature off. Spelling errors are noted in the document with a red underline. Grammar 
errors are indicated by a green underline. To disable this feature, select Tools|Options from 
the menu bar and click the Spelling and Grammar tab on the dialog box. Uncheck "Check 
spelling as you type" and "Check grammar as you type", and click OK. 

To use the spelling and grammar checker, follow these steps: 

1. Select Tools|Spelling and Grammar from the menu bar.  
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2. The Spelling and Grammar dialog box will notify you of the first mistake in the document and 
misspelled words will be highlighted in red. 

 
3. If the word is spelled correctly, click the Ignore button or click the Ignore All button if the word appears 

more than once in the document.  
4. If the word is spelled incorrectly, choose one of the suggested spellings in the Suggestions box and 

click the Change button or Change All button to correct all occurrences of the word in the document. If 
the correct spelling is not suggested, enter the correct spelling in the Not In Dictionary box and click 
the Change button.  

5. If the word is spelled correctly and will appear in many documents you type (such as your name), click 
the Add button to add the word to the dictionary so it will no longer appear as a misspelled word.  

As long as the Check Grammar box is checked in the Spelling and Grammar dialog box, Word will check the 
grammar of the document in addition to the spelling. If you do not want the grammar checked, remove the 
checkmark from this box. Otherwise, follow these steps for correcting grammar: 

1. If Word finds a grammar mistake, it will be shown in the box as the spelling errors. The mistake is 
highlighted in green text. 

 
2. Several suggestions may be given in the Suggestions box. Select the correction that best applies and 

click Change.  
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3. If no correction is needed (Word is often wrong more than it is right), click the Ignore button.  

Synonyms 
Word 2000 has a new feature for finding synonyms. Simply right-click on the word and select 
Synonyms from the shortcut menu. From the list of suggested words, highlight the word you 
would like to use or click Thesaurus... for more options. 

 
Thesaurus 
To use the thesaurus, select Tools|Language|Thesaurus from the menu bar or select it 
from the Synonyms shortcut menu as detailed above. 

 
A list of meanings and synonyms are given on the windows. Double-click on the words in the 
Meanings box or click the Look Up button to view similar words. Double-click words in the 
Replace with Synonym box to view synonyms of those words. Highlight the word you would 
like to add and click the Replace button. 
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Macros 
 
Macros are advanced features that can speed up editing or formatting you may perform often in a Word 
document. They record sequences of menu selections that you choose so that a series of actions can be 
completed in one step.  

Recording A Macro 
To record a macro, follow these steps:  

1. Click Tools|Macro|Record New Macro on the menu bar. 

 
2. Name the macro in the Macro name field. This name cannot contain spaces and or begin with a 

number.  
3. From the Store macro in drop-down box, select the document you would like the macro to be 

associated with or choose "All Documents" be able to use the macro in any document.  
4. Enter a description of the macro in the Description field. This is for your reference only so you 

remember what the macro does.  
5. Click OK to begin recording.  
6. Select options from the drop-down menus and Word will record the options you choose from the dialog 

boxes, such as changing the margins on the Page Setup window. Select only options that modify the 
document. Word will not record toggle actions such as View|Toolbars that have no effect on the 
document itself.  

7. The recording toolbar will allow you to stop, pause, and resume recording. 

 
8. Click the Stop button the recording toolbar. The macro is now saved.  

Running A Macro 
To run an existing macro, follow these steps. 

1. Select Tools|Macro|Macros from the menu bar.  
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2. From the Macros window, highlight the Macro name in the list and click Run. 

 
3. If the macro is long and you want to stop it while it is running, press BREAK (hold CTRL and press 

PAUSE).  

 

Table of Contents 

Word will automatically create a Table of Contents page if a document is designed using 
Heading and Paragraph styles (see the Styles section). Follow the steps on this page to 
create a Table of Contents. 

Mark Table of Contents Entries 

1. Highlight a heading that you would like to appear in the Table of Contents (TOC).  
2. Press ALT+SHIFT+O and the Mark Table of Contents Entry box will appear. 

 
3. Entry - Rename the entry if you would like a different heading to appear in the TOC.  
4. Table identifier - Select "C".  
5. Level - Choose "1" for first-level heading, "2" for second-level heading, etc.  
6. Click the Mark button.  
7. The document will be toggled to "reveal codes" view and notice the TOC field code. To hide all codes 

click the Show/Hide codes button on the standard toolbar.  
8. Select another heading to add to the TOC, or click the Close button on the Mark Table of Contents 

Entry dialog box.  
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Generate a Table of Contents 
After you have marked all the headings for your TOC, follow these steps to generate the 
Table of Contents. 

1. Place the cursor where you would like the TOC to appear in the document.  
2. Select Insert|Index and Tables from the menu bar. 

 
3. Customize the appearance of the TOC from the Table of Contents tab. You may choose a preset 

design from the Formats drop-down menu. A preview of each design will be shown in the Print 
Preview window.  

4. Check the Show page numbers box if you would like page numbers to show on the TOC. Check the 
Right align page numbers box if the page numbers should appear on the right side, then select the 
Tab leader between the heading and the page number. Uncheck the box if the page numbers should 
appear right next to the heading.  

5. Click OK.  

 

Web Page Wizard 

Word's Web Page Wizard will help you quickly create web pages for the Internet with preset 
layouts and graphics. Follow these steps to create a web page using the wizard. 

1. Select File|New... from the menu bar.  
2. Click the Web Pages tab on the New dialog box.  

“Yogidham”, Kalawad Road, Rajkot – 5 Ph : 2576681 34



Shree M. & N. Virani Science College 

 

3. Highlight the Web Page Wizard icon and click OK.  
4. Click the Next button on the first Web Page Wizard box.  
5. Title and Location - Enter a title for your web site and select the location on your computer where the 

files will be saved. Click Next when finished. 
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6. Navigation - Select a navigation type for the web page. Separate page is usually the best choice as it 
is the easiest to use. 

 
7. Add Pages - The next screen will list the pages currently in the web site. Click the Add New Blank 

Page button to add a new page, and highlight a page in the list and click Remove Page to delete pages 
from the web site. To add a page that you have already created to the site, click the Add Existing File... 
button and select the page you want to add. 

 
Click the Add Template Page... to insert a page with a layout. Highlight the choices in the Web Page 
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Templates window to preview the template in the main window. Click OK to select a template. 

 
8. Organize Pages - Reorder the pages of the web site. Highlight the name of the page that will be moved 

and click the Move Up and Move Down buttons. Click Rename to rename a page. 

 
9. Visual Theme - Select No visual theme for a blank page or select check Add a visual theme and click 

Browse Themes... to select a graphical theme. 
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From the Themes window, highlight the themes in the list to preview them. Check the Vivid Colors and 
Active Graphics boxes to apply those options. Uncheck the Background Image box to remove the 
graphic from the background of the page. Click OK when finished. 

 
10. Click Finish to create the web site.  
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Mail Merge 
 
How do I start a mail merge? 
 
You can use the Mail Merge Helper to create form letters, mailing labels, envelopes, or catalogs. The Mail Merge 
Helper guides you through organizing the address data, merging it into a generic document, and printing the 
resulting personalized documents.  
 
Open or create a main document, which contains the generic information that you want to repeat in each form 
letter, mailing label, envelope, or catalog. 
 
Open or create a data source, which contains the data that varies in the merged documents — for example, the 
name and address of each recipient of a form letter. The data source can be an existing spreadsheet, database, 
or text file, or a Word table that you create by using the Mail Merge Helper. 
 
In the main document, insert merge fields, which are placeholders that tell Microsoft Word where to insert data 
from the data source. 
 
Merge data from the data source into the main document. Each row (or record) in the data source produces an 
individual form letter, mailing label, envelope, or catalog item. You can send the merged documents directly to a 
printer, or to e-mail addresses or fax numbers. Or you can collect the merged documents into a new document 
so you can review and print them later.  
 
What types of data sources can I use? 
You can use just about any type of data source that you want, including a Word table, Microsoft Outlook contact 
list, Excel worksheet, Microsoft Access database, or ASCII text file. If you haven't already stored information in a 
data source, Word guides you step by step through setting up a Word table that contains your names, 
addresses, and other data. Learn about mail-merge data sources. 
 
 

Create form letters 
 
Step 1: Open or create the main document 

1. Do one of the following:  
o Open an existing letter. 

o Create a new letter.  
2. On the Tools menu, click Mail Merge. 

3. Under Main document, click Create, and then click Form Letters. 

4. Click Active Window.  

The active document becomes the main document.  

Step 2: Open or create the data source 

1. In the Mail Merge Helper dialog box, do one of the following:  
o Create a new data source. Use this method if you haven't already stored the names, addresses, 

and other data in a data source, and want to store the data in a Word table. 

o Use data in an existing data source. Under Data source, click Get Data, and then click Open 
Data Source. Select a Microsoft Word document, or a worksheet, database, or other list, and 
then click Open. Click Edit Main Document. 
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o Use addresses from an electronic address book. Under Data source, click Get Data, and then 
click Use Address Book. Select an address book, and then click OK. Click Edit Main Document.  

Step 3: Edit the main document and insert merge fields 

1. In the main document, type the text that you want to appear in every form letter. 

2. Insert merge fields where you want to merge names, addresses, and other data from the data source. 
To insert a merge field, click in the main document, click Insert Merge Field on the Mail Merge toolbar, 
and then click the field name you want.  

3. After you complete the main document and insert all of the merge fields, click Save As on the File menu. 
Name the document, and then click Save.  

Step 4: Merge the data into the main document 

1. On the Tools menu, click Mail Merge. 

2. If you want to specify the order in which data is merged, or to merge only part of the data, then you can 
sort and select data records to merge. 

3. If you want to see how the merged data will appear, then you can preview the merged documents. 

4. In the Mail Merge Helper dialog box, click Merge under Merge the data with the document. 

5. If you want to check the data source for errors before you merge, click Check Errors. Choose an option, 
and then click OK. 

6. Do one of the following:  
o Send the merged letters directly to a printer. In the Merge to box, click Printer, and then click 

Merge. 

o Store the merged letters in a new document, so you can review, edit, and print them later. 

o Distribute the merged letters to e-mail addresses or fax numbers.  

 
Use a Microsoft Access database as a mail-merge data source 

 
You can select as a data source any table or query defined in a Microsoft Access database. 
If you select a table 
 
Word retrieves the table each time you use the data source. Unless the table has been changed in Microsoft 
Access, it contains the same data fields and data records it contained the last time you used the data source. 
 
If you select a query 
 
To always use the data records retrieved by the original query instructions, clear the Link to query check box. 
This option is available only with Microsoft Access version 1.1 or later. 
If you expect the query instructions to change and you want to use information selected by the latest query, 
select the Link to query check box. Each time you use the data source, Word carries out the current instructions 
of the query. If the original instructions in a linked query have been modified — for example, if the query specifies 
different data fields or tables — the data selected by the query can change. The data records selected by the 
current query are used as the data source.  
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For example, suppose a query selects data records that identify the top products sold each month. You are 
preparing a report that analyzes holiday buying trends in December. To "freeze" the data source so that it always 
reflects December sales, clear the Link to query check box. Conversely, if you use the data source to track the 
leading sellers in your monthly sales reports, make sure that you select this check box. 
Note   Whether you select a table or select or link a query, Word always retrieves the latest information in the 
data records. 

 
Create a new Word data source 

1. Make sure you've already set up the main document.  
2. If you don't see the Mail Merge Helper dialog box, click in the main document, and then click Mail Merge 

on the Tools menu. 

3. Under Data source, click Get Data, and then click Create Data Source. 

4. In the Field names in header row box, specify the data fields that you want to include in the data source:  
o To delete a data field, click the field name in the Field names in header row box, and then click 

Remove Field Name. 

o To add a data field, type a new field name in the Field name box, and then click Add Field 
Name. 

o To change the order of the data fields, click a field name in the Field names in header row box, 
and then click one of the arrow buttons.  

5. When you finish specifying the data fields, click OK. 

6. Locate the folder that you want to save the data source in, type a file name, and then click Save. 

7. Click Edit Data Source. 

8. In the Data Form dialog box, fill in the information for each data record:  
o To fill in a record, type information for a data field, and then press ENTER to move to the next 

field. If you don't want to include information for a particular field, press ENTER to skip the field. 
Don't type spaces in the box. 

o To start a new data record, click Add New.  
9. When you finish entering data records, save the data source by clicking View Source, and then clicking 

Save on the Standard toolbar. 

10. To return to the main document, click Mail Merge Main Document on the Database toolbar.  

Preview merged documents 

1. Make sure you’ve already set up the main document, selected a data source, and inserted merge fields 
in the main document.  

2. If you see the Mail Merge Helper dialog box, click Close. 

3. Click anywhere in the main document, and then click View Merged Data on the Mail Merge toolbar.  

Microsoft Word displays information from the first data record in place of the merge fields.  

4. To view information from other data records, click the arrow buttons on the Mail Merge toolbar, or type a 

record number in the Go to Record box and press ENTER.  
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Tip   To print the main document with the currently merged data, click Print on the 

Standard toolbar. 
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